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AGENDA

• Introduction
– Key Concepts

– Primary Challenges

• PTC Best Practice Storyboard
– Model Based System Engineering

It is recommended that the reader has some 

knowledge of SysML

• OMG SysML Specification -

http://www.omg.org/spec/SysML/1.3/

Note

http://www.omg.org/spec/SysML/1.3/
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PTC VISION HIGHLIGHTS

Closes the loop with smart, connected products 

operation to understand how product, users, and the 

environment truly interact

Provides visibility into manufacturing and 

service feedback to inform next generation development

Validates requirements cradle-to-grave to 

ensure customer needs and quality expectations are met

Fully integrates systems engineering 

with product engineering in a single source of  truth

Manages collaboration and change 

within and across different disciplines

Enables holistic system definition and 

design, including early manufacturing and service plans

Closed-Loop Lifecycle Management
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A holistic, multi-disciplinary and collaborative approach 
to designing and maintaining complex systems.

SYSTEMS ENGINEERING IS…

Validation
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Systems Engineering Enablers

HOW WE DO IT WITH PTC INTEGRITY  

Systems Engineering 
Challenges Design

more 

innovative 
products 

using a 

collaborativ

e, model-

based 

systems 

engineering 
approach.

Validate

products 

meet 
requirements

and best 

practice 

processes 
are followed.

Reuse

systems 

artifacts to 
enable 

profitable 

product line 
engineering. 

Requirements, system models, 
design and test cases in many 
formats and systems

Lack of collaboration due to 
disconnected engineering 
disciplines 

Teams overwhelmed by the 
complexity of managing product 
lines

No standards-based process or 
techniques for systems engineering 
or product line engineering

Limited or no 
system Reuse
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• The Unified Modeling Language (UML) is an OMG Standard, general-
purpose modeling language in the field of software engineering, 
which is designed to provide a standard way to visualize the design 
of a system.

WHAT IS UML? 

UML Models
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• The Systems Modeling Language (SysML) is an OMG standard 
(extension of UML), general-purpose modeling language for systems 
engineering. It enables the specification, analysis, design, 
verification and validation of a broad range of systems and systems-
of-systems.

WHAT IS SYSML? 

SysML Models
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• MBSE is a model-based approach to Systems Engineering, typically 
applying the SysML modeling language to deal with system 
complexity and enabling unambiguous communication amongst 
interested parties

WHAT IS MODEL BASED SYSTEM ENGINEERING?

System 

Models

Software

Mechanical

Electrical

Analysis

Manufacturing

Marketing

Management

System

System Context Model Use Cases Model

Functional Model

Structural Model

Requirements

Service

(Device, Cloud, 

Mobile)
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• MBPLE is a model-based approach to the analysis and design of 
product families (or product lines), to capitalize on the 
commonality & variation between the products (systems, software, 
etc.) in these families

WHAT IS MODEL BASED PRODUCT LINE 
ENGINEERING?

Product Line System 

Model

+

Variability

=

VP

V V V

Car Types

VP

for the city

V

for the family

V

to impress the neighbors

V

1..1

Up front design for variability
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• Modular Design is an approach which segments the design of 
whole systems into linked, manageable and reusable sub-system 
designs

WHAT IS MODULAR DESIGN?

Module (Asset) 

Library

Module

System Model

Expand product offering 

while reducing costs
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SYSTEMS ENGINEERING
SOLUTION SCOPE

Practice Groups

Systems Engineering

Requirements Engineering

o Collaborative requirements definition

o Accurate requirements analysis and approval

o Comprehensive requirements traceability

o Standardized requirements and test change 

management

Test Management

o Comprehensive test traceability and coverage

o Collaborative test definition and authoring

o Managed test execution and results analysis

o Integrated test planning

o Standardized requirements and test change 

management

System Design

o Model Based System Engineering

o Automated System Design Review

o System Level Simulation

o System Model Management

o System Model Publishing

o Domain Specific Languages Implementation

Product Line Design

o Model Based Product Line Engineering

o Architected Modular Design

o Product Line Analysis and Validation

System Engineering Process Governance

o Standardized System Engineering Best Practices

o Tailored System Engineering Practice Application
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• A common process for constructing a SysML system model involves 
an iterative approach based around the SysML diagram taxonomy 

– Each iteration corresponds to a layer of abstraction of the system and involves the capture of 
requirements relevant to that layer, followed by the definition of structural and behavior elements 
necessary to meet those requirements

– Work would then progress on the next layer(s) to model sub-systems

– Work within the iteration such as defining the structural and behavioral elements can be done in 
parallel

MODEL BASED SYSTEM ENGINEERING APPROACH

Layer 1 – Capture system requirements and 
domain. Define system model for this layer

Layer 2 – Cascade requirements from previous 
layer and refine/derive/decompose. Iteratively 

update system model to incorporate 
requirements and designs for this layer

Layer 3 – Cascade requirements from previous 
layer and refine/derive/decompose. Iteratively 

update system model to incorporate 
requirements and designs for this layer

A

B

D E

C

F G

H I J

This is an example – the  

number of layers needed 

will depend on the system

Note
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• A top down modelling approach can produce a comprehensive definition 
of a product or system starting from the highest level down, but is not always 
practical or realistic

– A bottom up approach should also be considered, where definition of critical aspects or sub-
systems of a product are prioritized

– Middle out is where additional detail is captured at the same level of abstraction

– Often a combination of these approaches works best

MODEL BASED SYSTEM ENGINEERING APPROACH

Considerations 

A

B

D E

C

F G

H I J K L

Top down

Bottom up

Middle out
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• Often customers are looking to improve existing products, so model the 
parts of the system they plan to re-use only to the level of detail needed, 
enabling re-design of specific sub-systems

• Consider if product variability will be required
– Refer to the Model Based Product Line Engineering storyboard for more information 

• Large, complex systems can be managed using the Asset Library, allowing 
modular components to be created and re-used within multiple models. 
Requirements, use cases and interfaces are cascaded down when assets 
are re-used. 

– Refer to the Architected Modular Design storyboard for more information 

MODEL BASED SYSTEM ENGINEERING APPROACH

Considerations 
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AGENDA

• Introduction
– Key Concepts

– Primary Challenges

• PTC Best Practice Storyboard
– Model Based System Engineering
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• Practice: 
– Enable collaborative complex system engineering using a 

common industry standard modeling language

• Capabilities:
– Graphically define product context and stakeholders

– Map and trace from requirements to the design

– Model architecture including system functions and structure

• Value:
– Improve communication between stakeholders and engineering 

teams

– Improve product quality by early problem identification and 

enhanced design integrity

– Increase productivity by reuse of model elements and improved 

impact analysis

– Reduce risk with improved estimation and early requirements 

validation 

MODEL BASED SYSTEM ENGINEERING 
BEST PRACTICE

Challenge: Designing complex systems within disconnected engineering disciplines
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BEST PRACTICE
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Plan Systems Engineering Initiative

Capture constraints

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Define objectives, 

scope and process

SE Project CFT

Establish cross-

functional team

Define quality and 

performance 

measures and 

targets

Identify re-use 

candidates

Refine and confirm 

plan
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Define and Analyze System Context

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0
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Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Capture system domain 

information in 
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Create and configure 

system model

Analyze, refine and 

update system domain 

information
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Analyze Requirements

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Analyze and refine 

requirements

Confirm 

requirements

Update and baseline 

system model

Capture system or sub-

system requirements with CFT
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Design Use Cases
Define use cases and 

relationshipsDefine system actors with CFT

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Associate use cases to 

requirements
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Design Functional View

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System

Engineer

System 

Engineering 

CFT

Create sequence 

diagram with CFT

Define lifelines and messages
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Design Architecture
Define system 

blocks

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System

Engineer

System 

Engineering 

CFT

Define internal blocks, 

ports and item flows

Define constraint 

blocks and 

parametric diagrams

Review system 

architecture design
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MODEL BASED SYSTEM ENGINEERING PROCEDURE 
OVERVIEW

► Allocate Architecture

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System

Engineer

System 

Engineering 

CFT

Allocate system behavior 

to system structure

Map system architecture to mechanical, 

electrical and software entities

Plan physical 

architecture 

alternatives

Analyze, review 

and refine 

architecture 

alternatives

Select preferred 

physical 

architecture
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PLAN 
SYSTEMS ENGINEERING 
INITIATIVE
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Plan Systems Engineering Initiative

• Objectives

– Define a plan for the systems engineering program, project or phase

• Role

– Project/Program Manager

– System Engineer

– Cross-functional Team

• Outputs

– Plan for the systems engineering initiative covering objectives, scope, 

process, constraints, domain, resources, re-use opportunities and 

quality/performance measures and targets

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System

Engineer

System 

Engineering 

CFT / Project 

Manager
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MODEL BASED SYSTEM ENGINEERING

► Plan Systems Engineering Initiative

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

1.1

System

Engineer

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

System 

Engineering 

CFT / 

Project 

Manager

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0
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Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

MODEL BASED SYSTEM ENGINEERING

► Define Objectives and Scope

System

Engineer

Therefore it is important to coordinate with related disciplines and processes

Locate and verify any existing requirements, 

objectives, scope, domain, process, 

constraints, performance measures/targets

There are many different starting points for a Systems Engineering 

initiative:

– Development of a new product or product platform

– Adapting existing product or platform

– New requirements or regulations

1.1

System 

Engineering 

CFT / 

Project 

Manager
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MODEL BASED SYSTEM ENGINEERING

► Define Objectives and Scope

System

Engineer

In coordination with other processes, define draft objectives, 

scope and process for the systems engineering project
Source: INCOSE, Wikipedia

Refer to PTC System Engineering Process Governance 

practices for guidance on lifecycle process , PTC 

Integrity Process Perspective and Process Director

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

1.1

System 

Engineering 

CFT / Project 

Manager
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MODEL BASED SYSTEM ENGINEERING

►Establish Cross-functional Team

Ensure representatives from all affected 

departments are members of the cross-

functional team.  This may include:

- Marketing / Sales

- System Engineering

- Software / Electrical / Mechanical 

Engineering

- Manufacturing

- Service

System 

Engineering 

CFT

System

Engineer

SoftwareMechanic

al

Electrical

Analysis

Manufacturing

Marketing

Manageme
nt

System

SE Project CFT

Additional input may also be 

obtained from external parties such 

as suppliers, partners, regulatory 

agencies and customers but these 

are not part of the core CFT.

Note

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.3

1.4

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

1.1

1.2

Service

(Device, Cloud, 

Mobile)
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MODEL BASED SYSTEM ENGINEERING

►Capture Constraints

System 

Engineering 

CFT

System

Engineer

Confirm constraints such 

as regulatory 

compliance and 

company or industry 

standards

Include any known 

engineering limitations 

or constraints

PTC Mathcad

Also consider business constraints 

such as project deadlines  and 

milestones, or release/sales 

schedule

Note

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.4

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

1.1

1.3
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MODEL BASED SYSTEM ENGINEERING

►Define Quality and Performance Targets

System 

Engineering 

CFT

System

Engineer

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

Identify Re-use 
Candidates

1.5

Refine and Confirm   
Plan

1.6

1.1

1.4

Coordinate with Quality Mgmt processes and 

define quality and performance measures

If possible also set quality and 

performance targets

This is an 

advanced, 

optional technique

Note
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MODEL BASED SYSTEM ENGINEERING

►Identify Re-use Candidates

System 

Engineering 

CFT

System

Engineer

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

Identify Re-use 
Candidates

Refine and Confirm   
Plan

1.6

1.1

1.5

Identify re-use 

candidates from existing 

systems or designs and 

review with CFT

Consider existing SysML models 

for similar products

If using the Asset Library, 

evaluate any existing 

components or assets that 

may be re-used. Refer to the 

Architected Modular Design 

Best Practice for more 

information
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MODEL BASED SYSTEM ENGINEERING

►Identify Re-use Candidates

System 

Engineering 

CFT

System

Engineer

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

Identify Re-use 
Candidates

Refine and Confirm   
Plan

1.6

1.1

1.5

Evaluate existing 

mechanical, electrical of 

software designs for 

possible re-use

Existing MCAD 

(Mechanical Computer 

Aided Design)  designs

Existing software designs 

Existing ECAD (Electrical 

Computer Aided Design) 

designs
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SE Project CFT

MODEL BASED SYSTEM ENGINEERING

►Refine and Confirm Plan

System 

Engineering 

CFT / Project 

Manager

System

Engineer

Start Procedure 1

End Procedure 1

Establish Cross-
functional Team

Capture Constraints

Define Quality and 
Performance Measures 

and Targets

Define Objectives, Scope 
and Process

1.2

1.3

1.4

Identify Re-use 
Candidates

Refine and Confirm   
Plan

1.1

1.5

1.6

Review and confirm plan 

with CFT

If needed update plan objectives, scope, 

process, constraints, CFT, quality and 

performance targets and re-use 

candidates

Kick off and manage 

project
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DEFINE AND ANALYZE 
SYSTEM CONTEXT
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Define and Analyze System Context

• Objectives

– Capture, document and analyze system domain information

• Role

– System Engineer

– Cross-functional Team

• Outputs

– System Domain Model
Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Define and Analyze System Context

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Create and Configure System Model

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Enabler supports 

collaborative model 

development (setup 

during Modeler 

installation)

Select File > Open 

Model… to open 

Enabler and review 

existing Repositories 

and Models

Coordinate with related 

processes such as 

Requirements Management, 

Quality Mgmt and identify any 

relevant existing information  

If using Asset Library, this 

may be a collection of 

linked models for systems 

and sub-systems

Note
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MODEL BASED SYSTEM ENGINEERING

► Create and Configure System Model

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Notify those involved in the modelling 

activity which model(s) and version is 

being used and how to access 

Repositories can be 

managed using the 

Repository Administrator

Refer to System Model 

Management Best Practice 

for more information

Note

Access permissions on 

models can be defined
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MODEL BASED SYSTEM ENGINEERING

► Create and Configure System Model

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Select File > New Model to 

create new system model

Select Options – choose SysML 

(Full Profile) and enter name

If needed, import the SysML 

Profile (Tools > Add Profile)

Note

Profile extensions can be used to support a 

customer specific data model 

Note
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MODEL BASED SYSTEM ENGINEERING

► Capture System Domain in Consultation with CFT
Navigate to the Packages view, 

right click on the Truck System 

and select New > Package
System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Enter a suitable 

name for the 

package

Can be renamed easily 

by selecting the item and 

changing the Name field 

value

Additional packages can 

be created to structure 

and organize model 

elements
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MODEL BASED SYSTEM ENGINEERING

► Capture System Domain in Consultation with CFT

Right click on a package and select New > 

Diagram > SysML > Block Definition Diagram

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

New diagram created 

within the new package

Blocks, in SysML, provide 

a means of describing a 

system as a hierarchy of 

modular components, 

each of which can have 

a set of structural and/or 

behavioral features

Note
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Note

Blocks are internal to the system 

and actors are external.  Blocks 

are typically things we can 

manage or control

MODEL BASED SYSTEM ENGINEERING

► Capture System Domain in Consultation with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Capture all physical entities involved in the system such as users, operators as well as 

non-human entities such as equipment, facilities and technology for the user interface

Add Blocks to the model to 

represent the entities within 

the system domain

Define Actors that 

interact with the 

system
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MODEL BASED SYSTEM ENGINEERING

► Capture System Domain in Consultation with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Define associations between system domain entities

This is a 

Composite 

Aggregation 

association

This is a standard association from 

the Truck Domain block to the

FuelStationOperative actor
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MODEL BASED SYSTEM ENGINEERING

► Capture System Domain in Consultation with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Representative 

images can be 

used for diagram 

entities

Right click on the entity 

and select View Options > 

Edit > Select Image
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►Analyze, Refine and Update System Model

System 

Engineering 

CFT

System

Engineer

Start Procedure 2

End Procedure 2

Capture System 
Domain in  

Consultation with CFT

Analyze, Refine and 
Update System 
Domain Model

Create and Configure 
System Model

2.2

2.3

2.1

Update model with any 

changes as needed

There may be incomplete information 

available at this point so the creation of block 

and internal block diagrams should occur 

iteratively and recursively  as more system and 

sub-system requirements are identified. Further 

iterations occur in the following procedures

Note

Conduct a review of the system domain model with the CFT to 

confirm that the model accurately represents the domain in focus

Perform analysis to 

confirm model is 

complete and correct 

(Refer to Automated 

System Design Review 

Best Practice)

A

B

D E

C

F G

H I J
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ANALYZE REQUIREMENTS
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Analyze Requirements

• Objectives

– Capture, analyze and refine system and sub-system requirements 

• Role

– System Engineer

– Cross-functional Team

• Outputs

– Requirements Model
Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Analyze Requirements

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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Capture System or 
Sub-system 

Requirements with 
CFT

MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Coordinate with related 

processes such as 

Requirements Management, 

Quality Mgmt and identify any 

relevant existing information  

Requirements may be stored 

in Lifecycle Manager or other 

requirements management 

tools

This storyboard covers a MBSE approach to defining requirements. 

Lifecycle Manager provides structured text based requirements 

management and can be used in conjunction with Modeler

Note
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Capture System or 
Sub-system 

Requirements with 
CFT

MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Determine the level and area of focus within 

the system and sub-systems

A

B

D E

C

F G

H I J K L

Top down

Bottom up

Middle out

Cascade requirements 

down from higher levels if 

appropriate
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MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System

Engineer

Collect drivers for the new system 

from the Requirements Management 

system

For more details on how to capture requirements in 

Lifecycle Manager, please refer to Collaborative 
Requirements Definition Best Practice Storyboard
BP Storyboard

Note

Capture System or 
Sub-system 

Requirements with 
CFT

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Synchronization of requirements between Lifecycle 

Manager and Modeler is often iterative and includes 

additions, deletions and modifications 

Note

https://pds.ptc.com/Windchill/servlet/AttachmentsURLRedirectServlet?oid=VR:wt.doc.WTDocument:1095898828
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MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System

Engineer

Pass requirements from Lifecycle Manager to 

Modeler and vice versa.

Use the ‘Integration for Lifecycle Manager.’

Capture System or 
Sub-system 

Requirements with 
CFT

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Review imported 

requirements that will drive 

system development
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Capture System or 
Sub-system 

Requirements with 
CFT

MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Include any other 

relevant subject matter 

experts, potentially 

including customers and 

end product users

Note

Capture data using 

SysML Requirements 

and Requirements 

Diagrams 

Perform system 

requirements gathering 

sessions with the cross-

functional team

A requirement specifies a capability or condition that must (or should) be satisfied. A requirement 

may specify a function that a system must perform or a performance condition a system must 

achieve

Note
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Capture System or 
Sub-system 

Requirements with 
CFT

MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Requirements toolbar
Create new 

Requirement

Define Requirement 

properties.

Text tab allows 

additional textual 

information to be 

recorded
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Capture System or 
Sub-system 

Requirements with 
CFT

MODEL BASED SYSTEM ENGINEERING

► Capture System or Sub-system Requirements with CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Identify/confirm constraints 

and performance measures. If 

required, cascade 

requirements and capture 

sub-systems requirements

Capture what capabilities, functions or services the system or sub-system 

must perform. Identify any actors that have an interaction with the system

Decompose 

requirements where 

needed

Constraints 

can be added
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► Analyze and Refine Requirements

Refer to the System Engineering Process Governance and 

Efficient Design Review practices for additional information 

on system engineering reviews

Note

Review, analyze and refine and 

requirements with the CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.3

3.1

Update and Baseline 
System Model

3.4

3.2

Review requirements 

definitions and associations 

to other requirements

Validate correctness and 

eliminate overlap

Perform analysis to confirm model is 

complete and correct (Refer to Automated 

System Design Review Best Practice)

Analyze and review requirements for sub-systems 

within the context of the overall system

Note
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► Confirm Requirements
Confirm and approve all 

requirements with the CFT

System 

Engineering 

CFT

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Update requirements 

model if needed
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MODEL BASED PRODUCT LINE ENGINEERING BEST 
PRACTICE

► Confirm Requirements

System

Engineer

Pass System Level Requirements, Model 

Elements and Trace Links to Lifecycle 

Modeler

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4
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MODEL BASED SYSTEM ENGINEERING

► Update System Model

Update system domain model if needed 

(refine system structures in system domain 

model)
System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4
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► Update System Model

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

Creating a new version is a common 

way to baseline the model. Launch 

the Model Explorer (or select File > 

Open from with Modeler)

Select the model and click New to 

create a new version
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MODEL BASED SYSTEM ENGINEERING

► Update System Model

System

Engineer

Start Procedure 3

End Procedure 3

Analyze and Refine 
Requirements

Confirm Requirements

Capture System or 
Sub-system 

Requirements with 
CFT

3.2

3.3

3.1

Update and Baseline 
System Model

3.4

If a copy of the file needs to be stored in 

another location, Export can be used.

Choose File > 

Model > Export

Select a location 

and enter a name 

for exported model 

(.zip format)
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DESIGN USE CASES
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Design Use Cases

• Objectives

– Capture and document use cases and relationships

• Role

– System Engineer

– Cross-functional Team

• Outputs

– Use Case Model
Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Design Use Cases

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define/Confirm System 
Actors with CFT

4.2

4.3

4.1

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Design System Actors with CFT

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Use case diagrams focus on system 

behavior. They describe the usage of 

a system (subject) by its actors 

(environment) to achieve a goal, 

which is realized by the subject 

providing a set of services to selected 

actors

Note

Right click on a 

suitable package 

and click New > 

Diagram > SysML > 

Use Case Diagram

Work with the CFT to 

identify and 

document use cases
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MODEL BASED SYSTEM ENGINEERING

► Design System Actors with CFT

Confirm the name of the new diagram 

and specify any other options

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Add Actors to represent any entity 

that will interact with the system

Define properties for Actor
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MODEL BASED SYSTEM ENGINEERING

► Define Use Cases and Relationships

Add use cases for the 

significant functions or 

services the system must 

deliverStart Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Interaction 

type 

relationship

Include type 

relationship

Use cases can 

be created at 

any level within 

the system 

hierarchy

Note
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MODEL BASED SYSTEM ENGINEERING

► Define Use Cases and Relationships

Use case descriptions 

can also be created to 

provide further 

information and also 

capture multiple 

scenarios

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Create Text diagrams to 

capture textual 

descriptions of use cases
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► Associate Use Cases to Requirements

Drag and drop the existing 

requirement into the use 

case diagram window

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Add a Refine 

relationship 

between use 

case and 

requirement (Use 

Refine as we are 

still modelling the 

problem domain)

Use cases provide additional details on the behavior needed to implement a 

requirement.  Therefore it can be useful to link a requirement to it’s related use 

case
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► Associate Use Cases to Requirements

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

As with Block Definition Diagrams, it is possible to put a 

system boundary onto a use case diagram

Select Frame Box and 

drag the box around 

the use cases in the 

system
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To navigate from a 

requirement to related use 

cases or use case diagrams, 

right click on the requirement 

and select Report > Usage

MODEL BASED SYSTEM ENGINEERING

► Associate Use Cases to Requirements

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Related use cases 

and use case 

diagrams are 

displayed in the 

Results window. 

Related diagrams 

can be opened 

by double 

clicking

This view shows 

usage, it does not 

show actual links 

between model 

item. Refer to the 

next slide for 

more information

Note
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To display all relationships between model 

items use the Relationship browser

MODEL BASED SYSTEM ENGINEERING

► Associate Use Cases to Requirements

Start Procedure 4

End Procedure 4

Define Use Cases and 
Relationships

Associate Use Cases 
to Requirements

Define System Actors 
with CFT

4.2

4.3

4.1

System 

Engineering 

CFT

System

Engineer

Locate the requirement and 

expand the Dependents folder

Relationships are 

displayed, in this case 

the Refine link between 

requirement and the 

Load use case
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DESIGN FUNCTIONAL VIEW
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Design Functional View

• Objectives

– Define functional interactions and preliminary functional architecture

• Role

– System Engineer

– Cross-functional Team

• Outputs

– Interaction Model

– Functional Architecture ModelAnalyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Design Functional View

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1
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MODEL BASED SYSTEM ENGINEERING

► Create Sequence Diagram with CFT

System 

Engineering 

CFT

System

Engineer

The Sequence diagram describes the 

flow of control between actors and 

systems (blocks) or between parts of a 

system. This diagram represents the 

sending and receiving of messages 

between the interacting entities called 

lifelines, where time is represented 

along the vertical axis

Note

For use cases that need to be documented in more detail, 

specifically describing the interactions between actors and the 

system, a sequence diagram can be used

Enter name 

for diagram 

and select 

options

Right click on the use case and 

select New  >Sequence 

Diagram 

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1
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MODEL BASED SYSTEM ENGINEERING

► Create Sequence Diagram with CFT

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1

System 

Engineering 

CFT

System

Engineer

Click on Sequence  and 

then click in diagram 

window below the text 

Description. Add a 

sequence to the diagram 

and enter a name

A new actor 

can be added, 

but if the 

correct actor 

already exists 

in the model, 

drag and drop 

into the 

diagram as 

shown below
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► Define Lifelines and Messages

Add BlockProperty items to the diagram 

to represent system components

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1

System

Engineer

Drag and drop existing BlockProperty 

items (created earlier and displayed 

on Internal Block Diagrams)

Select Operation 

to add a 

message

Drag line from 

the actor to the 

BlockProperty

Can re-use existing 

operation or create a 

new operation

Lifeline
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► Define Lifelines and Messages
The operation will be added to diagram 

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1

System

Engineer

Enter a name and 

define properties 

as needed

Continue to add 

operations to define 

the sequence of 

interactions

Logical constructs can be 

defined within the sequence

Operations describe 

functions that should be 

provided by the system

Note
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MODEL BASED SYSTEM ENGINEERING

► Define Lifelines and Messages

Start Procedure 5

End Procedure 5

Define Lifelines and 
Messages

Create Sequence 
Diagram with CFT

5.2

5.1

System

Engineer

Operations become part of the target block 

and are displayed on diagrams (if 

compartment is visible)

Right click on the block and 

select Show/Hide 

Compartments…
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DESIGN ARCHITECTURE
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MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Design Architecture

• Objectives

– Design, analyze and review system architecture

• Role

– System Engineer

– Cross-functional Team

• Outputs

– System Architecture Model
Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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MODEL BASED SYSTEM ENGINEERING

► Design Architecture

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Review System 
Architecture Design

6.4
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MODEL BASED SYSTEM ENGINEERING

► Update System Model

Creating a new version of 

the model 

System 

Engineering 

CFT

System

Engineer

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

Before commencing the detailed design of the system, create 

another baseline of the model. System requirements should be 

frozen and only be modified via a managed change process

Note

Access permissions 

can be defined for 

the model
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► Define System Blocks

System 

Engineering 

CFT

System

Engineer

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

A

B

D E

C

F G

H I J

Cascade requirements down from higher 

levels and define Block Definition Diagrams 

and Internal Block Diagrams to describe the 

various sub-systems

When creating the various models in 

previous steps, system requirements will 

have been refined and elaborated and 

more there will be a greater understanding 

of the needed system/sub-system structure 

as well as system functions

Sub-systems that can stand-alone may be 

better defined as a separate system 

model and then linked using Asset Library

Note
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► Define System Blocks

System 

Engineering 

CFT

System

Engineer

Engine sub-

system

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

Truck sub-system block 

definition diagram

Dashboard sub-system

Ignition 

sub-

system

ECU software 

component

Additional diagrams can 

be created to define the 

block structure for lower 

level sub-systems



91

MODEL BASED SYSTEM ENGINEERING

► Define System Blocks

System 

Engineering 

CFT

System

Engineer

Note that BlockProperty entities are created where blocks are 

associated. (Composite aggregations are defined as parts on the parent 

block). This is also displayed in the Package view 

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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MODEL BASED SYSTEM ENGINEERING

► Define System Blocks

System 

Engineering 

CFT

System

Engineer

Various properties such as  

attribute values, parts, 

references and associations 

can be displayed or hidden

Right click on a block and 

select Show/Hide 

Compartments

Choose what 

information to display

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define System Blocks

System 

Engineering 

CFT

System

Engineer

Block Properties 

can be added 

to blocks to 

capture  

attribute values

Select the 

Attribute menu 

and choose 

Block Property

Click on the 

Block that the 

attribute will be 

added to
Name the property. 

It is displayed in the 

package hierarchy 

and diagrams

SysML includes a 

model of 

common SI units 

that can be re-

used

Select a data type for the 

attribute (Real primitive type 

selected in image)

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Define Interface Blocks

Select a suitable package and 

right click. Select New > SysML 

> Structure > Interface Block

Interface blocks do not need to be 

added to diagrams, so are 

created directly in a package

Enter a name and specify options

Interface blocks are specialized 

blocks that have no behaviors 

or internal parts and are used to 

type Proxy Ports (used in Internal 

Block Diagrams)

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Capture more details on 

the internal structure of 

each block using an 

Internal Block Diagram 

Right click on a block and 

select New > SysML > Internal 

Block Diagram

Define diagram 

properties

Block Definition Diagrams (BDDs) show the structure 

of the system functions. Internal Block Diagrams 

(IBDs) look inside the blocks to define the 

data/information/item flows and the ports

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Add a Block Property

Select Block 

type. Create 

suitable Block 

first if needed

Right click on 

the Block 

Property and 

select View 

Options

Optionally show 

name, full name, 

type, multiplicity, 

etc.

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Define ports and connectors
Ports are points at which external 

entities can connect to and interact 

with a block in different or more 

limited ways than connecting directly 

to the block itself. They are properties 

with a type that specifies features 

available to the external entities via 

connectors to the ports

Add new Block 

called Engine and 

click on Proxy Port

Ports and flows can be used to 

enable design of modular, 

reusable blocks with clearly 

defined ways of connecting 

and interacting with their 

context of use

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Click on the top edge of the 

Engine block

Can also create a new 

Interface Block  type 

Note

Select type for new port – we 

will use the Engine Mount 

Interface Block created earlier

Port definitions may be driven by system 

requirements (e.g. communication 

network protocols)

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Name the port and 

choose options

Text can be 

repositioned

Right click on the port and 

select View Options

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Add a port to the Chassis 

block and then add a 

Shallow Connector 

Ports and connectors represent an interface between 

system entities. This concept is explained further in a 

later procedure. 

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Internal Blocks, Ports and Item Flows

System 

Engineering 

CFT

System

Engineer

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

Complete definition of internal 

blocks, ports and item flows

Define the 

data/information/item 

flows between the system 

blocks
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► Define Constraint Blocks and Parametric Diagrams

System 

Engineering 

CFT

System

Engineer

Constraint Blocks can be 

optionally defined within BDDs to 

represent system properties such 

as cost, power output, weight, flow 

rate etc.

Parametric diagrams are used to 

define how the parameters for the 

constraint relate to specific value 

properties of the sub-system block

Parametric diagrams and 

constraint block should be 

used to capture non-

functional requirements

Note

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4
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► Define Constraint Blocks and Parametric Diagrams

System 

Engineering 

CFT

System

Engineer

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

Complete definitions of 

any constraints and 

parametric diagrams

Co-ordinate with 

performance and quality 

processes when defining 

constraints 
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► Review System Architecture Design

System 

Engineering 

CFT

System

Engineer

Start Procedure 6

End Procedure 6

Define System Blocks

Define Internal Blocks, 
Ports and Item Flows

Define Constraint Blocks 
and Parametric Diagrams

6.1

6.2

6.3

Review System 
Architecture Design

6.4

Coordinate with related 

processes and identify any 

relevant existing information:

Automated System Design 

Review, Verification and 

Validation, Test Management

Analyze and review 

system model and 

system architecture 

with CFT

Update system 

model if needed
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ARCHITECTURE



106

MODEL BASED SYSTEM ENGINEERING BEST PRACTICE 
PROCEDURE
► Allocate Architecture

• Objectives

– Define traceability from requirements to system architecture. Plan 

physical architecture

• Role

– System Engineer

– Cross-functional Team

• Outputs

– Associations from Requirements to System Architecture Model

– Physical Architecture plans

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer
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► Allocate Architecture

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Analyze Requirements

Design Architecture

End

Allocate Architecture

Define & Analyze
System Context

Start

2.0

3.0

Design Use Cases

Design Functional  View

4.0

5.0

6.0

7.0

Plan Systems 
Engineering Initiative

1.0

System 

Engineering 

CFT

System

Engineer

Select Preferred  
Physical Architecture

7.5
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► Link System Behavior to System Structure

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Allocation can be used to link system 

behavior to system structure, in this case 

linking the Operate Truck Sequence diagram 

with the Truck Block Definition Diagram

Right click on a 

sequence 

diagram and 

select Start 

Link…

Right click on the block definition 

diagram to be linked and select End 

Link…

Select Allocated To as the 

relationship and click OK
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► Link Requirements to System Architecture

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

This allocation can be seen in the 

Properties of the linked items 

A note can be added to the 

Sequence Diagram to indicate 

the relationship

Software designs 

can also be 

allocated to system 

blocks
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► Link Requirements to System Architecture

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Navigate model relationships to view 

traceability from blocks back to requirements

Right click on 

block and 

select Report > 

Usage

Review results to identify 

sequence diagram

Double click to open 

sequence diagram

Right click on diagram title 

and select Find > In 

Relationship Browser

Use case will be highlighted in Relationship 

browser. Expand and select Depends On 

folder to view linked requirements
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► Map System Architecture to Mechanical, Electrical and Software Entities

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Determine sub-systems or parts 

that require mechanical, 

electrical or software 

components
Truck Assembly

Powertrain

Engine

ECU

ECU software

Truck.asm

Preliminary Design 

Structure

Executables

MCAD 
Model

ECAD 
Model

ECU block will require a physical casing, 

electrical circuits and embedded software
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► Map System Architecture to Mechanical, Electrical and Software Entities

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Use the system 

block structure 

to derive  and 

plan the 

physical 

structure. Note 

that this is a 

manual step

Truck Assembly

Chassis

Suspension

Powertrain

Engine

Transmission

Differential

Load Bay

Day Cab

Preliminary PDMLink 

Product Structure
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► Map System Architecture to Mechanical, Electrical and Software Entities

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Block properties can be mapped to attributes on the 

physical models (Parts, CAD Documents or ECAD data)

Truck Assembly

Powertrain

Engine

Attributes:

Power Output
Capacity
Compression Ratio
CO2 Output
…..
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► Map System Architecture to Mechanical, Electrical and Software Entities

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Attributes, operations, 

constraints and interfaces 

in the system model can 

all drive software design

UML packages and class models can be 

created in Modeler and code can be 

generated from the models. Lifecycle 

Manager can be used to manage software 

source code (Integrated Software Mgmt)
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► Map System Architecture to Mechanical, Electrical and Software Entities

Identify interfaces by reviewing associations 

in the structure model

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Review BDDs and identify 

relationships between blocks 

that require an interface to be 

defined and managed

Review ports and 

connectors on IBDs 

to identify potential 

interfaces
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► Map System Architecture to Mechanical, Electrical and Software Entities

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Plan the interfaces needed in the physical 

architecture and related design models

Truck Assembly

Powertrain

Engine

ECU

Truck.asm

Preliminary Design 

Structure

Electro-
mechanic

al interface 
(ECU to 

PCB)

Define and agree interface 

specifications and assign ownership

Transfer of power interface 
(Engine > Transmission)

Transmission

Attachment/
Assembly 
interface 
(Engine > 

Transmission and 
ECU)

Plan the realization of interfaces in 

design models (Refer to Interface 

Definition and Mgmt best 

practice)
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► Plan Physical Architecture Alternatives

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Also consider product options and 

variants – refer to the Model Based 

Product Line Engineering best practice 

for more information

Consider architecture alternatives 

to ensure all options are evaluated
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► Analyze, Review and Refine Architecture Alternatives

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer

Refer to the Efficient 

Design Review best 

practice for more 

information

Review and refine architecture alternatives with CFT
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► Select Preferred Physical Architecture

CFT will then select the optimum 

physical architecture to best meet the 

system requirements

Start Procedure 7

End Procedure 7

Map System 
Architecture to 

Mechanical, Electrical 
and Software Entities

Plan Physical  
Architecture Alternatives

Analyze, Review and 
Refine Architecture 

Alternatives

Allocate System Behavior 
to System Structure

7.2

7.3

7.4

7.1

Select Preferred  
Physical Architecture

7.5

System 

Engineering 

CFT

System

Engineer
SE Project CFT

Truck Assembly

Powertrain

Engine

ECU

Truck.asm

Transmission
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